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What follows is an outline I made for writing the class notes, followed by the notes themselves.  The 
two go together as an example of how outlines can evolve into a finished paper.

I. Introduction
    A. Name and credentials
    B. Class survey
    C. Outline of topics to be covered
    D. Persona Pentathalon standards

II. The Two Most Important Questions
    A. Problem Statement or Topic Question
    B. Why is it important?

III. Picking a Topic
    A. Should not be something you can open a book and answer
        1. New perspective on something
        2. Cross-disciplinary perspective
    A. Can take time
    B. Survey of literature helpful
    C. Get the right scope
        1. In time
        2. In space

IV. Outlining
    A. Parts of a paper
        1. Introduction
        2. Body
            a. Background
            b. Sources of evidence
            c. Argument
            d. Counter-argument
        3. Conclusion
    B. Organizes structure of argument
    C. Assists in talking about your paper
        1. With librarians
        2. With Scadians
    D. Guides your source selection - which sections need references?
    E. Organizes your notes
    F. Will be frequently revised

V. Sources
    A. Types
        1. Primary (and primary-ish)



            a. Original manuscripts or artifacts!
            b. Fascimiles
            c. Transcriptions
            d. Translations
        2. Secondary: scholarly papers, archaeological reports, etc.
            a. Use university library database to find, OR
            b. Use bibliography of a tertiary source and/or Internet, then Interlibrary
                 Loan (ILL)
        3. Tertiary: Books with many footnotes
        4. General knowledge: Books without footnotes, but with bibliographies
        5. Other: e.g., expert testimony
    B. Finding sources
        1. Library
        2. Internet
        3. Citation surfing
    C. Bad sources
        1. “Everybody knows”
        2. “Oral tradition”
        3. Revealed knowledge (typically religious)
    D. Organizing them for writing

VI. Bibliography
    A. Generally, if it’s in your bibliography, you should cite it.
    B. If you cite it, it should be in your bibliography
    C. See http://owl.english.purdue.edu/ for formatting
    ----- But basically, enough information that I can find what you used
    D. If you use a quote in another source, there’s a format for that - don’t cite
         the original document.
        
VII. Citations
    A. End notes vs. footnotes
    B. Notes vs. bibliography entries
    C. Rules for citations (MLA, Chicago Manual of Style) at http://owl.english.purdue.edu/
        1. Parenthetical with bibliography
        2. Superscript with endnotes or footnotes (and bibliography)
        ---- “Quoth the raven, ‘Nevermore.’”1

    D. When in doubt, put more information in
VIII. Style
    A. Can use style guides for this too
    B. Readability
        1. Font size (10-12), color (black)
        2. Alignment (left), spacing (double)
        3. Use of bold, italics, etc.

4. 1” - 1.25” margins
        5. Boring > Creative
    C. Organization

1. Edgar Allen Poe.  “The Raven,”  The American Review, Feb 1845, 35. 



        1. Follows the outline
        2. Built-in or customized Word headers enable easy Table of Contents
        3. Table of Contents for long works
        4. Pagination

5. Boring > Creative 
D.  Writing
    1. Clear sentences.  
    2. Unpretentious language
    3. Active voice
    4. Get a proofreader

    E. Appearance
        1. Clean cover sheet
        2. Folder, cover, even binding
        3. Staples, paper clips, binder clips

KASF Pentathalon Research Paper Standards

Documentation
4: Superior handling of all phases of documentation. Excellent annotation and bibliography; excellent 
choice of source materials, including specialized references directly related to the subject material 
and/or primary sources incorporated appropriately.

5: Documentation would be acceptable in a scholarly journal.

How to get it: Go to a university library to get the best sources.  Then follow the guidelines of an 
accepted style guide (typically MLA or Chicago Manual of Style) to format your annotations and 
bibliography.

Relevant Sections of the Class: Sources, Citations

Authenticity
4: Subject matter of the paper is period and it has relevancy to an SCA member.  It is written with an 
SCA audience in mind.

5: Subject matter of the paper is period and it has relevancy to an SCA member.  It is written with a 
scholarly audience in mind.

How to get it: Choose an appropriate problem statement/thesis topic.  An academic audience would be 
interested in your topic’s repercussions beyond how it applies to re-enactment.  

Relevant Sections of the Class: Two Most Important Questions, Picking a Topic

Complexity
3: Providing new research to the SCA; Use of scholarly sources and some primary sources. Average 
sized paper.

4: Extensive scope of research, new to the scholarly community. Complex topic. Use of source material



in other languages. Significant use of primary sources. Conclusions supported by personal 
experimentation. Lengthy paper.

How to get it: Again, great sources from a good library.  Use citation surfing to expand your collection 
of sources and ensure that you’re well-grounded in the literature of the research community.  Pick the 
right thesis topic - an unanswered question, or a new answer to an old question, from that community.
 Take your time - a dissertation (which is what this describes) can take upwards of a year to write, for a 
full-time student.

Relevant Sections of the Class: Two Most Important Questions, Picking a Topic, Sources

Workmanship
4: Good organization of ideas, good word choices and sentence structure. Minor typographical or 
grammatical errors.

5: Excellent organization of ideas, flow of argument, supported conclusions. No typographical or 
grammatical errors.  Attractively presented.

How to get it: Practice writing.  If you have problems with grammar, spelling or punctuation, get a 
patient proofreader and buy yourself some books on grammar.  Have others go over your outline and 
your drafts, to ensure that your ideas flow logically. 

Relevant Sections of the Class: Outlining, Style

Two Most Important Questions

Number One
The topic, problem statement, hypothesis or thesis topic is the question motivating your research.

• What is a plausible reconstruction of a late period English maypole dance?
• How should I translate the Anglo-Saxon poem Wulf and Eadwacer?
• Why did Germanic lyres die out and were replaced by triangular harps?

Number Two
Why should anybody care?

This addresses the relevancy, the importance, the significance of your work.  Don’t be shy.  (But also 
don’t be too grandiose.)

• An authentic maypole dance will bring back an Elizabethan folk tradition, and will make a fine 
showpiece at a spring demo.  It will also educate a public accustomed to seeing Victorian 
“ribbon dances” as authentic Renaissance practice.  And it means more flirting!

• The poem is highly ambiguous, with scholars advancing many different possibilities over the 
years.  Any translation should be aware of these ambiguities and either try to capture them, or 
else settle on a meaning and translate with that in mind.

• Records of early Middle Ages music are thin on the ground.  Identifying trends which result in 
the adoption of a new instrument over a traditional one may shed some light on the preferred 
performance styles of the era.



Picking a Topic

The greatest mystery of the academia/research world... those who can do it, get grants.  Those who 
can’t, work for those with the grants.

If you can open up a book and find the answer to your problem question, then you aren’t doing original
research.  Original research requires:

• An investigation of something totally new, or
• Looking at old information through a new lens (e.g., women’s studies, interpreting literature), or
• Extending existing research a bit past what’s been done, or
• Synthesis of many elements into a whole, when that synthesis requires original thought and 

interpretation (is not just a list of others’ work), which is often related to -
• Inter-disciplinary work, that draws new relationships between existing fields.

The SCA’s holistic approach makes us well-suited to inter-disciplinary work.

You may notice that most of these things require you to already know something about the field you 
want to do research in.  This is why academics tend to focus on one specific area and get really, really 
good at it.  The more you know, the more you know you don’t know - and the easier finding 
unanswered questions is.

When a field is new, you can go broad with original research.  
• Susan Mosher Stuard, Women in Medieval Society, 1976.

But as time goes on, you have to dig deeper, into more specific topics:
• Jessica E. Godfrey, Attitudes towards Post-Menopausal Women in the High and Late Middle 

Ages, 1100-1400, 2011.

On the other hand, for some times and places, sources are so limited that you have to broaden your 
scope in either geography or time to have any material to work with.

• What were the drinking songs of the Anglo-Saxons like?
• We can’t answer this question, as none have survived.  We have to ask a broader question.

Outlining

Outlining helps you organize your ideas and your notes, so it’s good to do it early.  Even if you’ll revise
your outline frequently as you go.

The “classic” version I grew up with is used for the course outline given at the front of these notes.
 The top-level sections are marked with Roman numerals (I, II, III).  Below that, sections are marked 
with capital letters (A, B, C).  Sub-sections are in small Roman numerals (i, ii, iii) and finally, if there’s
 more detail, use lower case letters (a, b, c).



But you could also use a more legal/business outline, with

Part 1
Section 1.1
Subsection 1.1.1
Subsection 1.1.2
Section 1.2

Part 2

as your format.

We were also taught:
• To use only very brief words or phrases for each part of the outline
• To make sure all the levels of the outline reflected the same grammatical construction

I think the first point is somewhat helpful, as it helps you to clarify and simplify your ideas.  Simple is 
good.  They told us in grad school that, if you really understood your material, you could explain your 
dissertation topic to your grandmother in five minutes.

The second point is more of a formalism.  I wouldn’t worry too much about it.

A paper can always be generically described as having an introduction/thesis, a body, and a conclusion.
(And as one professor slooooowly explained to a class I was in, if the thesis doesn’t match the 
conclusion, you need to rewrite the paper...).  But “II. Body” isn’t very useful.

I find most research can be presented as Introduction, Background, Sources/Evidence, Arguments, 
Counter-Arguments, and Conclusion.  But this isn’t a hard and fast rule, more a, well, a general outline.

Counter-Arguments?
• It’s unlikely that you’ll have found the One True Answer to some question.  There will probably

be other researchers with different answers.  It’s a really good idea to discuss their answers in 
your paper, and state why you think your answer is also valid.

• You do not have to try and show that you have the One True Answer.  This is something a lot of
grad students do, because they think that for their answer to look strong, they have to discredit 
all other answers.  Most mature researchers understand that there is room for various 
interpretations, and will find the contortions of these younger researchers rather amusing and 
unnecessary.

Sources

If it is at all possible, go to a university library to do your literature search.  They have amazing 
resources.  I maintain membership in an alumni association just so I can check out books from the 
university library system.  (Interestingly, it seems you don’t always even have to be an alumn to join 
those.  They like money.)

• Go to the university website and find the link to their library website.
• Use the online card catalog (most have them) to search for books



• Write down call numbers.
• Make a note of which library the book is in.  Many universities have several library buildings.
• Make a note if it’s in the Reference section.  You can’t check it out if it is.
• Go to the library or libraries.  They’ll have maps that tell you where the various call numbers 

are shelved.  You already know the books you want; head straight for them.  Browse the shelves
nearby.  Take notes, make copies, or check them out.

• While you’re there, hop onto the computers that house the periodical databases and search for 
relevant journal articles.  Ask a librarian for help if the system is giving you trouble.

• Profit!

Primary (or Primary-ish) Sources
According to the information specialists, a primary source is the original document/artifact.  Most of us
won’t get to use actual primary sources.

A facsimile is a color copy of an original, and is as close to a real primary source as many of us will 
get.  You may not be able to feel the texture of the pigments or the pinpricks of the compass used for 
layout; you may not be seeing the colors exactly as they are in real life.  But this is good stuff.  You can
find facsimiles in university libraries and sometimes on the Internet.

A transcription is when someone has gone over a manuscript and provided a typed copy.  Questions 
you might ask yourself: does this preserve the letter/word/line spacing of the original? Are spelling 
errors corrected?  Is pagination marked?  Were there illuminations?  Are their locations marked?

A translation is when someone (usually another modern person) interprets the original text for you.
 Although you get A&S points for using other languages, many of us only read English, so translations 
are necessary.  Get facing-page translations if you can (usually available for poetry).  Get an edition 
with good translator’s notes if you can.  Get several different translations, if it’s important.

How do you know if it’s important?  The more your arguments hinge on the precise meaning or page-
placement of a word, the more important it is know what that word really means/what it looked like.  

• If you are going to build a case for the performance of Anglo-Saxon poetry based on the word 
“harp” that you saw in a translation, you had better know that the original word hearpan could 
mean either a lyre or a triangular harp.

• If the precise meaning of a particular word is not as important, then you need to be less 
concerned about other possible interpretations

Secondary Sources
The only reason these are ‘hard’ is that they’re just about only found in university libraries.  So it takes 
some effort to get them.

Not as much as it used to.  No more “Index of Periodicals,” nope!  Modern database catalogues, 
searchable by keyword, just like Google.  In many cases, you can print out newer articles for the same 
price as photocopying them.  For older articles, you will still have to go to the stacks and find the print 
version.

In a publish or perish world, there are articles so, so many things.  Things you will never find an entire 
book on, you can find journal articles about.



They are extremely worthwhile.  No matter how smart you are, you are not as smart as an entire 
combined academic community over the past 130 years or so.  Their interpretations of the primary 
sources are sometimes dated, sometimes controversial, and usually worth reading.  Even if you reject 
them, you will be a better researcher for doing so purposefully, rather than by ignorance.

Tertiary Sources
A mainstay for many of us.  These are rather technical books, generally full of footnotes or end notes.
 Meticulously researched and annotated, they synthesize many smaller sources into some sort of 
coherent whole, illuminating trends and patterns.  They are readily available from mainstream 
booksellers - online.  They’re not very much in demand, and so they’re often not in the bricks-and-
mortar stores.

It is best not to quote a quote you see in a tertiary source.  That is, if the tertiary source quotes a 
primary or secondary source that interests you, it is best practice to go and find a copy of that primary 
or secondary source.  If you can’t, there is a way to note that “this quote was quoted in a book I read.”
 Don’t copy the tertiary source’s citation, as if you were using the actual primary/secondary source 
yourself. 

Example:
On page 105 of the imaginary tertiary source Housecats of the Gauls:  “Compare this to the poet Felix, 
writing c. 223 CE: ‘The purr delights/But oh, catfights/I do not like.’ (Felix 57).”

We find an bibliography entry for:  
Felix.  “On catfights.”  Poems about Cats.  Trans. B. Shumacher. Wiley and Sons: New York, 1998. 
Print.

In our paper, we reproduce the poem and the (Felix 57) parenthetical notation.  We do not copy the 
bibliography entry from Housecats.  Well, we do, but then we add to it:

Felix.  “On catfights.”  Poems about Cats.  Trans. B. Shumacher. New York: Wiley and Sons, 
1998, quoted in Carol Barber, Housecats of the Gauls, New York: Random House, 
2006, p. 105.

I started this example in MLA style, but the MLA resource I’m using doesn’t actually have a way to do 
this.  So I modified the Chicago Manual of Style’s guidelines for doing it.  The result is pretty clear, 
and anyone reading could go and find Barber’s book and then the Felix quote on page 105.

General Knowledge
The sort of history book readily available at most bricks-and-mortar commercial bookstores and county
libraries.  It may have a good bibliography, but the text will not be annotated with citations.  Not really 
your best bet for a good reference.

Citation Surfing
My name for a method of quickly surveying a field’s literature.  

• Start with whatever you can readily find relevant to your project, via Internet search, county 
library, online university card catalogue, Amazon.com book search, etc.

• If you have a general knowledge book, go through its bibliography and pick out the most 
promising sources.



• Take the names of your ‘best bets’ so far and Google them.  Possibly with the word 
“Publications” next to them.

• This often turns up the websites of academic researchers.  Look at their list of publications and 
write down the ones that look most promising.

• Keep going back to Google.  Sometimes you can find copies of journal papers online, or a book 
may have a substantial free preview in Google Books.

• Eventually, go to the library, or put in an Interlibrary Loan (ILL) request for your most 
interesting-looking sources.

• Get sources, read sources.  Read sources’ bibliographies.  Make a list of the most interesting-
looking sources.

• You may already be seeing the same names cropping up again and again, and maybe some of 
the same titles.  Make a note - you want to follow up on those.

• Repeat the “get sources, read sources, read bibliography” step until you stop seeing extremely 
interesting new papers or names come up, or until you have enough material to answer your 
research question.

Use With Caution (or Not At All)
• When I see the words “everybody knows,” my mind instantly substitutes, “I couldn’t be 

bothered to find a citation.”  Unless we’re talking about encyclopedia facts (the dates of a king’s
reign, the Roman name of a particular city), “everybody” is not a citable source.

• Oral history, folk tales, legends.  Many were collected in the 19th and 20th centuries.  Used with
care, they can be used to support an argument for something’s antiquity.  They are not usually 
sufficient on their own to make a strong case.

• Knowledge from divine revelation.  In areas where religion and history overlap, take care to 
distinguish historically supportable facts from religious truths.

Taking Notes from Sources

Old style: Use index cards.
• Start a numbered list of your sources.

• 1. Barber, Carol. Housecats of the Gauls. New York: Random House, 2006.
• Read, skim or search your source until you find a quote of interest to your paper:

• “Of 26 household records studied, 23 mentioned provisions for a housecat,” on page 72.
• Consult your outline.  Yes, your outline!  Where does this quote go?

• II. Evidence, B. Written sources, 3. Records, lists, etc.
• On an index card:

• Put the reference number (1) in one corner
• Put the outline reference (II-B-3) in the other corner
• Write the full text of the quote.

• I have never regretted having the full text
• I have often regretted only having a paraphrase.

• Write the page number on the right.



Figure 1: Taking notes from Source 1, for Section II-B-3
• Repeat for all your sources until done.
• Order cards by outline numbers.
• All your citations are ready to go!

Luddite!

I like having physical cards to manipulate, but... your outline is going to change.  Probably a lot.  Even 
after you start reading your sources.  Going through a stack of several dozen - or hundred - cards, 
changing all the outline numbers with whiteout, is not much fun.

You can do a similar thing with an electronic copy of your outline document.

II. Sources
    A. Images
    B. Written sources
        1. Essays
        2. Fiction
        3. Records, lists, etc.
            (1) “Of 26 household records studied, 23 mentioned provisions for a
                   housecat”   72.
            (1) “Eight [of the household records] mentioned more than one cat.”  73.

(The square brackets indicate that the text within them is not part of the original quote; you put that 
there so that later, you know the answer to the question, “Eight what?”)

Bibliographies and Notes

You will have a bibliography or works cited page.  The exact format of the entries will depend on the 
style guide you are using, but the idea is for a random reader to be able to go out and find the book or 
article you used.

Bibliographies have their entries in alphabetical order.  Usually, this is by first author’s last name, but 



there are always exceptions.  The style guides tell you how to handle them.

MLA style doesn’t use footnotes (for citations); it uses parenthetical notations in the text that reference 
the bibliography entries.  (MLA does allow, but discourages, the use of footnotes or endnotes for 
necessary asides or commentary that does not fit easily into the main text.)

Chicago Manual of Style uses either footnotes or endnotes.  But it also has a bibliography.  The notes 
tell a reader exactly where a particular fact came from.  A bibliography lets them quickly see if a 
particular author has been cited anywhere in the work.

What Do I Cite?

Almost EVERYTHING.  If you present something as a fact, I want to know where you got it from.  

Direct quotes: when you copy an author word for word, cite that.
• Short quotes (~1-2 sentences or less) are quoted in your text.
• Longer sections of text are block quoted:

Lo, though it be a quote, it be not preceded nor followed by quotation marks.  The formatting 
doth render the marks redundant, and they must be omitted.  And yea, the text be indented, as 
with a tab.  And though the main body of the paper was writ with double-spaces, verily, the 
quote was but single-spaced.  Some may justify the text, so that the right margin be not broken 
as winter vines.  A double-space did precede it, and did follow it, the better to separate it - but 
not so greatly - from the other text.  And finally did come the superscript number for the 
footnote, or else the parenthetical notation in the manner of the MLA.  (Citation 79)

Paraphrases: when you write down the gist of what an author was saying, cite that.

Summaries: when you condense what an author has written into a sentence or two, cite that.

Images: Cite the sources of pictures used.

Data: You do not have to credit every datum, but if it is summarized in a table or chart, indicate where 
it came from (e.g., Norman Pipe Rolls Henry II, transcribed by The Pipe Roll Society, Vol 91 NS 53, 
Oxford, 2004.).

You can safely skip:

General Knowledge: You do not have to cite well-known historical facts (e.g., Geoffrey Chaucer was 
an English poet, Fredrick I Barbarossa lived from 1122-1190).

Your original contributions: Your arguments, inferences, and insights come from your own mind and 
are not referenced.

Comparison of Different Style Guides

Style Guides tell you how to format your citations and bibliography.
http://owl.english.purdue.edu/owl/resource/949/01/



Humanities: MLA Style Guide  (http://owl.english.purdue.edu/owl/resource/747/01/)
History: Chicago Manual of Style  (http://owl.english.purdue.edu/owl/resource/717/01/)

MLA
MLA doesn’t do footnotes.  It uses parenthetical notation and a bibliography.

You write:
According to Barber, “[e]ight [of the household records] mentioned more than one cat” (73).  

(A direct quote, author mentioned in the text.)

According to Barber, eight of twenty-six households documented supplies for multiple cats (73).  
(A paraphrase, author mentioned in the text.  Still cited! Cite all specific, non-general 
knowledge facts, even if you paraphrase them.)

In one survey of household records, eight out of twenty-six households were listing supplies for more 
than one cat (Barber 73).  

(Author not mentioned in text, so author put in parenthetical note.)

Then in a Bibliography at the end of your work, you cite:

Barber, Carol. Housecats of the Gauls. New York: Random House, 2006. Print.

(The “Print” at the end is new to me, and it indicates that this is a printed paper thing.  The other 
common alternative would be “Web,” although I suppose “Microfiche” and “Audio Recording” are two
other common ones.)

The Purdue Online Writer’s Lab (OWL) website given above has guidelines for formatting all kinds of 
strange parenthetical what-ifs (what if Barber wrote two books that we want to reference? What if there
is no author?  What if there are six authors?!)  and the corresponding bibliographical entries (what if 
it’s a translation of an essay in a edited collection that I found on the Web?).  Or you can go and buy 
your own copy of the MLA Style Guide.

It’s really that easy!

The Chicago Way

The Chicago Manual of Style (CMS) doesn’t care if you use footnotes (at the bottom of the page) or 
end notes (at the end of each chapter or the whole paper).  You will use a sequential superscript number
for each note.  You will also have a bibliography.

In Microsoft Word, footnotes are easy.  Go to Insert> Footnote to insert a footnote.  Word will 
automatically number them (and re-number them for you, if you go back and add or subtract some), 
and provide you with a place in the footer to type in your note.

Endnotes are trickier.
• Go to the end of your chapter or paper.
• Start a numbered list (button with 1--- 2--- 3--- on it)
• Enter your first-appearing endnote reference.



• If you want “Turabian style” (often used by students at universities), select the number and 
Format>Superscript it.

• Go back to the text where the quote is.
• At the end of the quote, do Insert>Cross-Reference>Numbered List
• Pick the appropriate endnote
• Select the inserted number and do Format>Superscript

This is a pain, but it is much less pain than renumbering everything by hand if you add or delete 
references.

You may have to right-click and “Update Fields” to see changes.

The OWL page again gives examples of footnotes/endnotes and bibliography entries.  The most basic 
citation and note (N) for a book is:

Here is some sample text.  Our sample text will assert “a generic quote for purposes of illustration.”1

1. Firstname Lastname, Title of Book (Place of  publication: Publisher, Year of publication), 
page number.

Note that the page number is given, and that the note is indented on the first line.  The reference 
number is not using the optional superscript formatting (Turabian style, for Kate L. Turabian's Manual 
for Writers of Research Papers, Theses, and Dissertations, 7th edition).  If it were a dissertation, the 
number would be superscript.  The number in the paper, at the end of the quote, is always superscript.

Then, in the bibliography (B), the same work is referenced:

Lastname, Firstname. Title of Book. Place of publication: Publisher, 
Year of publication.

Note that in the bibliography, the last name goes first, and it’s the lines after the first that are indented.

From http://owl.english.purdue.edu/owl/resource/717/01/

If you cite the same source and page number(s) from a single source two or more times 
consecutively, the corresponding note should use the word “Ibid.,”  an abbreviated form of the 
Latin “ibidem,”  which means “in the same place.” If you use the same source but a different 
page number, the corresponding note should use “Ibid.” followed by a comma and the new page
number(s).

What if you are citing a source you have previously cited, but not consecutively?  That is, you cited 
Barber, and the Felix, and now Barber again.  Do you have to write out the entire citation for Barber?  

From Wikipedia, http://en.wikipedia.org/wiki/Op._cit.

Op. cit. is an abbreviation of the Latin phrase opere citato, meaning "in the work cited".  It is 
used in an endnote or footnote to refer the reader to a previously cited work, standing in for 
repetition of the full title of the work. … For example, given a work called The World of 

http://owl.english.purdue.edu/owl/resource/717/01/
http://en.wikipedia.org/wiki/Op._cit


Salamanders (1999) by Jane Q. Smith, the style would typically be "Smith op. cit.", usually 
followed by a page number, to refer the reader to a previous full citation of this work (or with 
further clarification such as "Smith 1999, op. cit." or "Smith, World of Salamanders, op. cit.", 
if two sources by that author are cited).

The Chicago Manual of Style, 16th edition, considers that op. cit. and loc. cit. are "rightly 
falling into disuse", and "instead uses the short-title form", e.g. the form World of 
Salamanders, to use the example above. Various different styles call for other alternatives, 
such as a reference to the author's surname and publication year, e.g. "Smith 1999".

Consider this also a practical lesson on trusting online sources.  The OWL online free version of the 
CMS does not contain guidelines for op.cit., at least not that I can find.  Whenever possible, go to the 
original source to check your quotes.

(But Teleri, you didn’t do that!  You’re quoting Wikipedia, for crying out loud!

Good catch!  I didn’t use CMS for my dissertation; the university had its own style guide, and the 
papers I publish conform to other formats as well.  So I don’t own an MLA or CMS book, nor do I 
claim to be an expert in them.  But hey, at least I’m being honest that I’m citing Wikipedia, not just 
using the Wiki information to try and fool you into thinking I’ve gotten my hands on a copy of the 
CMS.)

Style

Unsurprisingly, the various style guides also offer guidance on formatting style.  If you are submitting 
to Tournaments Illuminated or Compeat Anachronist, and they tell you to “use MLA style” or “use 
Chicago Manual of Style,” then that is what you should do.

It is not a bad idea to use one of their styles even if you are just writing a paper for a competition.

If you don’t, though, here are some general things to keep in mind:

Readability
• Times New Roman is considered a highly readable font in print.  On a computer screen, Arial is 

considered one of the most readable.
• 12-point font is large enough to be easily readable for many.
• 1” margins all around is standard.  Some people like 1.25” at left and top.
• Double-spaced is the standard for typed manuscripts.  Personally, I am so used to single-spacing

in everything I read, in print and on the Internet, that I find it natural.  But it is Most Proper to 
double-space things.

• If you single-space anyway, for the love of all things good and true, leave a carriage return 
between paragraphs.  Single-spaced writing is easy to read, unless there’s just page after page 
of it, with no white space to denote any breaks at all.

• If you double-space, do not quadruple-space between paragraphs.  Use a tab to indicate a new 
paragraph.

• Use boldface, italics and underlining as appropriate.  Usually, that’s moderately sparingly, 
except in headers, where boldface is common.

• Boring is often better than creative.  Fancy calligraphy fonts and novelty formatting are 



distracting.

Organization
• In theory, your paper follows your most recent draft of your outline
• But note how these class notes don’t precisely follow my (unchanged) draft of the outline
• Give the reader all the necessary blocks before you start to build an argument
• It’s okay to remind the reader, in a longer paper, that ‘As I discussed in Chapter 2, the Romans 

frequently made special provisions for their cats.’
• Word has several pre-set sets of headers you can use for the various levels of your outline
• You can also customize your own (e.g., to fit MLA or CMS)
• If you use these, you can auto-generate a Table of Contents (ToC) if you want.  Insert>Table of 

Contents, I think.
• It will automatically update as you add, subtract, or move sections around.  (You may have to 

right-click on the ToC and pick “Update Fields” to see the changes.)
• Word has options to control pagination as well.  You may need to use section breaks 

(Insert>Break>Section Break) if you have special, fancy pagination needs.
• MS Word actually has really good help online and in the program if you’re having trouble 

getting it to do what you want to do.  Or Google it.
• Again, boring is often better than creative.  You want the emphasis of a research paper to be on 

the content of your ideas, not on flash.
• That doesn’t mean it shouldn’t be neat and clean and professional-looking.  But think of your 

paper as more of a banker, less of an interior designer.

Writing
• Write clear, simple sentences whenever possible.  Sometimes, a long and complex sentence is 

exactly what is needed to express a long and complex idea.  But avoid pretentiousness: 
• “Wherefore it can be shown that, pursuant to the acceptance of Miller’s hypothesis, it 

follows naturally that Benz’s logic is flawed.” - NO
• “If one accepts Miller’s idea, then Benz cannot also be correct.” - YES
• “If Miller is right, then Benz is wrong.” - OH YEAH!  (although potentially 

inflammatory)
• Use the active voice (“He threw the ball”) rather than the passive (“The ball was thrown.”)  It 

used to be, in scientific papers especially, “experiments were done” and “results were tabulated”
because it was seen as somehow rude to say that the writer did actual work.  (Or possibly false, 
if it was the writer’s graduate students who did it.)  The tide is starting to change in the direction
of “I did the experiment” and “We tabulated the results” instead.  It’s easier to read and 
understand.

• Get a proofreader.  Or several.
• A copy editor looks for errors in spelling, punctuation, and grammar.

• Ideally, a copy editor would know that’s an Oxford comma I just used.
• Also get someone to read over the work as a whole, to check the logical flow and 

coherence of your work
• Ideally, someone who has not been closely involved with your research (e.g., 

your Laurel).  Fresh eyes who don’t know all the details are best.
• If they ask you, “What do you mean by this?” listen very carefully to your 

answer.  Chances are, you have just spoken a better version of whatever you 
originally wrote.



Appearance
• I favor a clean cover sheet, with the title centered about one-third of the way down the page, and

my name, the event, and the date centered just above the bottom.
• There are various folders, binders, and report covers you can use.

• Or even have it spiral, comb, or heat-tape bound. (Staples or Office Depot can do it.)
• Or self-publish, if it’s particularly awesome work. (Places online can do this.)

• I could be persuaded to entertain a cover appropriate to a tertiary source
• If you paper is too thick to staple, and you don’t want to spring for binding, you can use paper 

clips or binder clips.  Or punch holes in it and use a 3-ring binder or folder with bendable 
prongs in it.

• Buy an ornamental plate stand, generally found in the picture frame section of a craft store.
 This is like a tiny tabletop easel, and you can use it to better display your paper among all the 
cool and shiny A&S artifacts.


